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Federal Copyright Law protects this publication, with all rights reserved.
No part of this publication may be copied, photocopied, reproduced, stored
in a retrieval system, translated, transmitted or transcribed, in any form or
by any means manual, electric, electronic, Electromagnetic, mechanical,

optical or otherwise, in whole or in part without prior written consent from
PhiLumina, LLC.

Limitation of Liability

Information presented by PhiLumina, LLC in this manual is believed to be
accurate and reliable. However, PhiLumina, LLC assumes no responsi-
bility for its use. No license is granted by implication or otherwise to any
rights of PhiLumina, LLC.

Product specifications and prices are subject to change without notice.
Trademark References

Trademarks and registered trademarks are proprietary to their respective
manufacturers.
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AlLumina

Advisories

Three types of advisories are used throughout this manual to
provide helpful information or to alert you to the potential for
hardware damage or personal injury. They are Notes, Cautions, and

Warnings. The following is an example of each type of advisory.
Use caution when servicing any electrical component.

1 NOTE An amplifying or explanatory comment related to
1.2—| procedural steps or text.

CAUTION
Used to indicate and prevent the following procedure or
step from causing damage to the equipment.

WARNING

Used to indicate and prevent the following procedure or
step from causing damage to the equipment.

Disclaimer: We have tried to identify all situations that may
pose a warning or caution condition in this manual. However,
PhiLumina, LLC does not claim to have covered all situations that
might require the use of a Caution or Warning,.

PHILUMINA, LLC.- Forward Thinking -
45 Hardy Court #355, Gulfport, MS 39507.
Ph: 228-363-4048 Email: info@philumina.com
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L ]
Safety Instruction

For your own safety and in order to guarantee safe operation of the system please read the
following information prior to use.

*Never operate the system in areas where water or dust might penetrate the housing.

*Place the system on a stable base. Shocks, like dropping the system onto the floor, might
cause serious damage to the device.

* Always unplug the system before cleaning it. Do not use cleaning liquids or sprays. Use
only a dry, soft cloth on the case. Clean the optics with non-scratching lens tissue and lens
cleaning fluid. Do not use strong solvents such as acetone.

*Make sure that the connecting cables are in good condition.

* Detach the system and contact the customer service in the following cases:
- When a cable or plug is damaged or worn-out.
-When water or other liquids have soaked into the device.
-When the device is not working properly after following all instructions in the
User’s Manual.
-If the system has been dropped or the housing has been damaged.

NOTE:
Before handling the PhiLumina Hyperspectral Imager, read the following
i: 3 instructions and safety guidelines to prevent damage to the product and to

cnsurc your own personal safety.

Refer to the “Advisories” section for advisory conventions used in this manual, includ-
ing the distinction between Warnings, Cautions, and Notes.

* Always use caution when handling/operating the instrument. Only

qualified, experienced, authorized electronics personnel should access the

interior of the instrument. The power supplies produce high voltages and
energy hazards, which can cause bodily harm.

* Use extreme caution when installing or removing components. Refer to
the installation instructions in this manual for precautions and procedures. If you have
any questions, please contact PhiLumina’s Technical Support.

Never modify or remove the radio frequency interference shielding from your instru-
ment. To do so may cause your installation to produce emissions that could interfere
with other electronic equipment in the area of your system.

PHILUMINA, LLC.- Forward Thinking -
45 Hardy Court #355, Gulfport, MS 39507.
Ph: 228-363-4048 Email: info@philumina.com
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In addition, take note of these safety guidelines when appropriate:
*When you disconnect a cable, pull on its connector or on its strain-relief loop, not on the cable
itself. Some cables have a connector with locking tabs. If you are disconnecting this type of
cable, press in on the locking tabs before disconnecting the cable. As you pull connectors apart,
keep them evenly aligned to avoid bending any connector pins. Also, before connecting a cable,
make sure both connectors are correctly oriented and aligned.

Warranty & Tech Support

Product Warranty

The PhiLumina Hyperspectral Imaging System carries a one-year warranty against defects
in materials or workmanship from the date of shipment to the original purchaser. Any
products found to be defective in material or workmanship will be repaired or replaced
promptly.

NOTE

Products that have been modified will not be covered under this warranty.

Warranty & Repair
Please contact PhiLumina regarding warranty repair before returning the product.

NOTE
]. All returns to Phil.umia for Repair/Replacement/ Credit must be
shipped back to PhiL.umina with shipping charges and duties paid.

Returns for Repair/Replacement/Credit

It is not required, though highly recommended, that you keep the packaging from the
original shipment of your PhilL.umina product. However, if you return a product to
PhiL.umina for warranty repair/ replacement, you will need to package the product in
a manner similar to

PHILUMINA, LLC.- Forward Thinking -
45 Hardy Courl #355, Gullport, MS 39507.
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The manner in which it was received from our plant. PhiLumina cannot be responsible for any physical
damage to the product or component pieces of the product that are damaged due to inadequate
packing,

Physical damage sustained in such a situation will be repaired at the owner’s expense in accordance
with Out of Warranty Procedures. Please, protect your investment; a bit more padding in a good box
will go a long way to ensuring the device is returned to us in the same condition you shipped it in.

Out of Warranty Repair
Repair for out of warranty PhiLumina manufactured products must be discussed with a technician
before arrangements for the repair can be made.

Once the product is received at PhiLumina, an evaluation of the product/unit will be performed and a
technician will contact you to discuss repairs and to obtain authorization for the repair work to be
performed.

Contacting Technical Support
For a quick response, send an email to techsupport@philumina.com with a detailed description of
your problem, or visit our web site at:

Qur support department can also be reached by phone at (228) 363-4048.
Support is available Monday through Friday, 8:00 AM to 5:00 PM CT-USA. When contacting
PhiLLumina Technical Support, please be sure to include the following information:

1.Name

2.Company Name

3.Phone Number

4.Fax Number

5.E-mail Address
6.PhiLumina Product Name
7.PhiLumina Serial Number
8.Computer Make
9.Computer Model
10.0Operating System and Version
11.Description of the Problem.

PHILUMINA, LLC.- Forward Thinking -
45 Hardy Court #355, Gulfport, MS 39507.
Ph: 228-363-4048 Email: info@philumina.com
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Returning Merchandise to PhiLumina

If service is required, and arrangements have been made with a PhiLumina’s representative, please ship
the well-packaged product to the address below:

PhiLumina, LLC 45 Hardy Court #355

Gulfport, MS 39507

USA

It is not required, though highly recommended, that you keep the packaging from the original shipment
of your PhiLumina product. If you return a product to PhiLumina for warranty repair/replacement you
will need to package the product in a manner similar to the manner in which it was received from our
plant. PhiLumina cannot be responsible for any physical damage to the product or component pieces of
the product (such as the host or expansion interfaces for PCI expansion systems) that are damaged due to
inadequate packing. Physical damage sustained in such a situation will be repaired at the owner’s
expense in accordance with Out of Warranty Procedures. Please, protect your investment; a bit more
padding in a good box will go a long way to ensuring the device is returned to use in the same condition
you shipped it in.

PHILUMINA, LLC.- Forward Thinking -
45 Hardy Court #355, Gulfport, MS 39507.

Ph: 228-363-4048 Email: info@philumina.com



VNIR 400H-USB

Setup and Operation

This manual is for use with PhiLumina, LLC Hyperspectral Imaging Systems product line. It gives an
overall view and process of the hardware, software, and its use.
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Introduction

The PhiLumina hyperspectral Imaging Systems hardware is designed to be easily setup and utilized via the
PhiLumina ‘s HSI software, which allows the end user to easily acquire, save, and pre-process quality
hyperspectral data (See the Philumina’s HSI Software Manual for more details on the use of PhiLlumina's HSI
software).

The Philumina Patented VNIR
400H portable scanning

Hyperspectral Imaging Camera on

High Powered Acquisition &
Processing Lunchbox
Computer

The PhiLumina VNIR 400H Series Hyperspectral Imaging System (400-1000 nm)

The imaging systems (independent of the spectral range and spatial resolution that separates the current
product line) all function in the same manner using the same PhiLumina HSI software user friendly interface.
The software has been designed to be user friendly without compromising the technical prowess of the internal
functionality for standard and improved data processing. Each system comes in a convenient carrying case,
documentation, warranty, and wavelength calibration files. The systems are calibrated at the PhiLumina's labs
and delivered to you the end user with the software and calibration files installed on the system computer.

NUVNIR350 VNIR400 SERIES VNIR400 MICROSCOPE

Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507

http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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SPECIFICATIONS

Certified by the Space Foundation

CERATIFIG S

> W
Q....I_ZUFOG

Data Transport

USB-2

Accessories (Included)

Sensor System

Portable Computer

Objective Lens

{ 10" X 10") 95% Reference Panel

( 2" Round ) 12.5% Reference Panel
Acquistion Software

Carrying Case

PHILUMINA-VNIR/400H

Sensor Type Pushbroom - Scanning Portable Turnkey Hype rspectral system
Performance (Addressable Hyperspectral Features)

Spectral Range (Continuous Coverage) 400-1000nm

# Spectra Channel stbands Up to 1000

# Spatial Pixels 1392

Field of view (Lens) 29 degrees

Fift Ff24

Spectral Width SamplingFow ~.6 nm centered
Spectral Resolution (FywHi) 2.8nm

Pixel Size 6.45um x 6.45um
Durarnic Range 14 bit

Frame Rae 20Mhz

Sriletkeystone Distortion <.5nm

oise Level 7 e-rms@20MHZ
Camera Tupe CCD/SONY ICX285AL
Lere mount standard [other % custorn rmownts per request] c-mount

Cacling Thermal Compensated

Dimensions, Weight, and Power
Item Dimensions (Infcm) Weight (Ib/Kg)
Sensor Footprint L(10") x W(4") x H(5")
L(25.4cm) x W({10.16cm) x H(12.7cm)
Sensor Weight 4.31bs/1.95kgs

On-site Setup and Training
upon reguest: ask for guote for these services.
for ENVI training please contact . Exelis - ENVI developers and Specialists.

http://www.philumina.com

ALL PHILUMINA' sensors are calibrated to traceable standards
Specifications subject to change

Soace Techaalogy

__9__2___:
h_“_._;

Motor Control

Motor Type Servo Thread Driven
Control Computer Controlled
Power Supply 24 Volt / Switchable Power
Portability

Mounting 2(1/4- 20) mounting Holes
Upright Microscopes YES

Tripods YES

Copy stands YES

Aircraft Mounts YES

s va:._.:_:::_ﬁ

Software and Data Processing

Function Software
Acquisition PHILUMINA' imaging software
Pre-processing PHILUMINA' imaging software

Operating System  Microsoft XP/win7
(Currently 32 & 64 bit operating systems)

Phone: 228-363-4048 Fax: 866-458-2404
Email: info@philumina.com

45 Hardy Court #355, Gulfport, MS 39507

Philumina, LLC

mina

ﬁ'aiLu
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SPECIFICATIONS

hiLumina

FEHOMRAD THINKING

Certified by the Space Foundation

Data Transport

USB-3

Accessories (Included)
Halogen Light Setup
Paortable Computer
Objective Lens

{ 10" X 10") White Reference
{ 2" Round ) Dark Reference
Acquistion Software
Carrying Case

Spare Technalogy

PHILUMINA-VNIR/400E "VNIR" Series

Sensor Type Pushbroom - Scanning Portable Turnkey Hyperspectral system
{Addressable Hyperspectral Features)
Performance
Motor Control
Spectral Range (Continuous Coverage) 400-1000nm
# Spectral Channelsbands Upto 1000 Motor Type Servo Thread Driven
1t Spatial Fixels 1920 Control Computer Controlled
Field of wiewd Lens ~29 degrees Power Supply 24 volt / Switchable Power
Fit Ff2.4
Spectral Width Sarmpling/Fiowe ~.6nm centered Portability
Spectral Rezalution [FiwHk) 2.8nm Mounting 2(1/4 - 20) mounting Holes
Pixel Size 4.54pm x 4.54um Upright Microscopes  YES
Diata Output [ Bit Range] 16 bit Tripods YES
Frame Rate 26 Hz Copy stands YES
Srmiletkewstone Distortion <.5nm Aircraft Mounts YES
Slit Size W xL) 30 pm X 14.2 mm
Camera Tupe CCD/SOMY ICX674
Lens mourt standard [ather & custorn mourts per request] c-mount n 2
Coalirg Uncooled /] mw_ UImina
Dimensions, Weight, and Power
Item Dimensions {Infcm}) Weight (Ib/Kg) Software and Data Processing
Sensor Footprint L{10") x W(4") x H{5") Function Software
L(25.4cm) x W({10.16cm) x H(12.7cm) Acguisition PHILUMINA' imaging software
Sensor Weight 4.31bs/1.95kgs Pre-processing PHILUMINA'imaging software
Operating System Microsoft XP/Win7
On-site Setup and Training {Currently 32 & 64 bit aperating systems}
upon request: ask for quote for these services.
for ENVI training please contact . Exelis - ENVI developers and Specialists. Minimum Laptop Specs: i3 processor, 4G Ram, 1T HDD,

17" LCDmonitor, Battery Life =3 hours

htitp://www.philumina.com

ALL PHILUMINA' sensors are calibrated to traceable standards Phone: 228-363-4048 Fax: 866-458-2404

Specifications subject to change Email: info@philumina.com

45 Hardy Court #355, Gulfport, MS 39507

http://www.philumina.com Ph: 228-363-4048 info@philumina.com

Philumina, LLC
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SPECIFICATIONS

Data Transport
Dual Camera Link or USB 3.0

Accesscrizs (Included)
Sensor System
Portable Computer / Laptop with USB3
Objective Lens
{ 10" X 10") 99% Reference Panel
(2" Round ) 12.5% Reference Panel
Acquistion Software
Carrying Case

Sensor Type
Performance

Spectral Range (Continuous Coverage)
# Spectral Channel slbands

# Spatial Pixels

Field of view

Ertrance Slit Size

Fi#

Spectral Width SamplingFow

Spectral Resolution [FwHM]

Pixel Size

Dunarnic Range

Frarre Rate

Srnil dkeystone Distort on

Noize Level

Camera Tupe

Lens mount standard [other & customn mounts per request)

Cooling

Dimensions, Weight, and Power

Item Dimensions (Infcm)
Sensor Footprint L(10") x W(4") x H(5")

Sensor Weight

On-site Setup and Training
upon request: ask for quote for these services.

www.philumina.com

L(25.4cm) x W(10.16cm} x H(12.7cm)

PHILUMINA-NUVNIR-350 "VNIR" Series

Pushbroom- Scanning Portable Turnkey Hyperspectral system
(Addressable Hyperspectral Features)

350-1000nm

»910 | <1000

2560 (usable ~80%)

30 degrees

30 pum % 30 mm

Ff2.4

approximately .7 centered
2.5nm

6.5um x 6.5um

16 bit

95.3Mhz

<.5nm

1.4 e-rms@95.3MHZ
sCMOS

c-mount

Peltier Cooled / with Fan

Weight (Ib/Kg)

4.31bs/1.95kgs

for ENVI training please contact . Exelis - ENVI developers and Specialists.

ALL PHILUMINA' sensors are calibrated to traceable standards
Specifications subject to change

Space Te
Mprovin
o Farth

Motar Control
Motor Type Servo Thread Driven
Control Computer Controlled

Power Supply 24 Volt / Switchable Power

Portability

Mounting 2(1/4 - 20) mounting Holes
Upright Microscopes  YES

Tripods YES

Copy stands YES

Aircraft Mounts YES

7~ h..-w__.:_,_::._.ﬁ

Software and Data Prccessing

Software

PHILUMINA Imaging Software
Pre-processing PHILUMINA Imaging Software
Operating System Microsoft XP/Win7

(32 & 64 bit operating systems)

Function
Acquisition

Phone: 228-363-4048 Fax: 866-458-2404
Email: info@philumina.com

= . PhiLlumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
WhiLumina

: 228-363-4048 info@philumina.com

http://www.philumina.com Ph

Page [13



SPECIFICATIONS

[ . Space Technology
_ PHILUMINA-SWIR/900B "SWIR" Series kgl
MF—HBW: a Sensor Type Pushbroom - Scanning Portable Turnkey Hyperspectral system
aseiaiae (Addressable Hyperspectral Features)
Motor Control
Certified by the Space Foundation  |Spectral Range (Continuous Coverage) 900-1700nm
# Spectral Channel sthands Upto230 Motor Type Servo Thread Driven
# Spatial Pixels 320 Control Computer Controlled
Field of view 30 degreas Power Supply 24Volt / Switchable Power
Fi F2
Spectral width Sampling/Fow ~2.5 nm centered Portahility
Spectral Rezolution (FwH!M) anm Mounting 2 (1/4 - 20) mounting Holes
Data Transport Pixel Size 30pm x 30pm Upright Microscopes  YES
UsSB 2.0 Dynarnic Range 14 bit Tripods YES
Accessories (Included) Frarne Rate 60H:z Copy stands YES
Sensor System Smiletkeystone Distortion <.3nm Aircraft Mounts YES
Portable Computer Moise Level 60db
Objective Lens Carnera Tupe InGaAs Detector
(10" X 10") 99% Reference Panel Lens mount standard (other & custorn mounts per request) c-mount oo | ;
(2" Square ) 12.5% Reference Panel  |Codling Forced Air Cooling " Hv? Cumina
Acquistion Software
Carrying Case Dimensions, Weight, and Power
Item Dimensions (Infcm) Weight (Ib/Kg) Software and Data Processing
Sensor Footprint L{11") x W{a") x H(5") Function Software
L(27.94cm) x W(10.16cm) x H(12.7cm) Acquisition PHILUMINA' imaging software
Sensor Weight blbs/2.72kgs Pre-processing PHILUMINA'imaging software
Operating System Microsaft XP/Win7
On-site Setup and Training (Currently 32 & 64 bit operating systems)
upon request: ask for quote for these services,
for ENVI training please contact . Exelis - ENVI developers and Specialists.
ALL PHILUMINA' sensors are calibrated to traceable standards Phone: 228-363-4048 Fax: 866-458-2404
.philumina.com Specifications subject to change Email: info@philumina.com

Page |14
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SPECIFICATIONS

Data Transport

USB 2.0

Accessories (Included)

Sensor System

Portable Computer

Objective Lens

(10" X 10") 99% Reference Panel

( 2" Square ) 12.5% Reference Panel
Acquistion Software

Carrying Case

PHILUMINA-SWIR/2500"SWIR" Series

sensor Type Pushbroom - Scanning Portable Turnkey Hyperspectral system
AR (Addressable Hyperspectral Features)

Spectral Range (Continuous Coverage) 1000-2500nm

# Spectral Channelslbands Upto 220

# Spatial Pixels 320

Field of view 30 degrees

Fi# F/2

Spectral Width SamplingFow ~2.5 nm centered
Spectral Resolution [FWwHM] Snm

Fixel Size 20um x 20pm
Dynamic Range 14 bit

Frame Rate 60Hz
Smiledkeystone Distortion <.5nm

Moize Level 61db

Carnera Type MCT Detector
Lens mount standard [other & custorn mounts per request) c-mount

Caaling Peltier Cooled
Dimensions, Weight, and Power

Item Dimensions (Infcm) Weight (Ib/Kg)

Sensor Footprint L(11") x W{4")} x H{5")

L{27.94cm) x W(10.16cm) x H(12.7cm)
Sensor Weight 6lbs,/2.72kgs
On-site Setup and Training

upon request: ask for quote for these services,

for ENVI training please contact . Exelis - ENVI developers and Specialists.

http://www.philumina.com

ALL PHILUMINA' sensors are calibrated to traceable standards
Specifications subject to change

Spate Technology
improvieg life
om karth

Motor Control

Motor Type Servo Thread Driven
Control Computer Controlled
Power Supply 24 Volt / Switchable Power
Portability

Mounting 2 (1/4 - 20) mounting Holes
Upright Microscopes  YES

Tripods YES

Copy stands YES

Aircraft Mounts YES

_.g;._::_::

Software and Data Processing

Function
Acquisition

Pre-processing
Operating System

Software

PHILUMINA' imaging software
PHILUMINA' imaging software
Microsoft XP/Win7

(Currently 32 & 64 hit operating systems)

Phone: 228-363-4043 Fax: 366-453-2404
Email: info@ philumina.com

Page [15
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UNPACKING YOUR HSI SYSTEM

NOTE
Your new HSI system will come in a padded water proof carrying case. The main
components and the main HSI Camera assembly will be in this case. Check your list

—| of components and be sure that all of them are present ( lights, tripod, power
supplies, etc. ).

-

CAUTION
Although your PhiLumina HSI product may be designed with international friendly

switching power supplies; some items like light power supplies may need to be
switched. Though they are checked at PhiLumina’s facilities; there is the possibility
that a switch may be missed.

SAFETY PROCEDURES

WARNING
Do not look into light sources and calibration lights, as they may

have damaging UV and/or intensity properties that can be dam-
aging to the eyes.

WARNING
' It is important to turn on the camera on the system before turning on the lighting
system. Some ARC based lamp systems can damage the cameras circuitry.

Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507

http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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Software Installation

WINDOWS INSTALLATION:

click on Philumina.exe.
2. Follow the instructions on the dialogs that are displayed during the install process.

under the drivers folder on the CD.

with your new PhiLumina HSI product.

1. Insertthe CD into the CD-ROM drive of your computer. The CD should start automatically. If
the menu does not start, go to the PhiLumina Install folder located on the CD and double

3. You will need to install the appropriate drivers for your camera. The drivers can be found

4. ltis important now to refer to the PhiLumina HSI Software Users Manual that was supplied

PhiLumina's HSI software is the heart of their hyperspectral imaging
product line. It runs on Win XP/Vista/7 Operating Systems. This
section of this manual shows how to install this software. However,
there is a separate software instruction manual that accompanies
your new PhiLumina product. The PhiLumina HSI software will be
pre-loaded and tested on your new system. However, there is also a
CD with your system that will allow you to re-install, if needed.

Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507

http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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Components VNIR400H

The PhiLumina HSI system hardware is made up of the following components for the Basic Setup:
e The Hyperspectral Sensor Head & Scanning Assembly
= The camera & Filters
e The cables and interface
e The high powered computer
= The fore lens

= The white Reference Panel

The Hyperspectral Sensor head and Scanning Assembly:

The scanning assembly is comprised of the
spectrograph, motor, patented focal plane scanner,
and c-mount attachments for the fore lens and other
mounting. The motor is found at the front of the
assembly above the focal plane scanner and the
motor control module is located at the top of the
scanning assembly right above the optics assembly.
This is all covered & protected by an assembly cov-

er.

The camera mounts to the scanner
assembly via a series of mounts as a
connection between the camera and
the optical mount. The two are bridged
together by a rotating mounting bracket

that is locked down during assembly

and mounted inside the Maotor Control

=3 NOTE: M42-mount, C-mount, Custom mounts &/Or Other mount type connections may be
5 used on your HSI system based on model and specification, for optimal performance.

" - Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
iLumina
http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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Components VNIR400H

Order Blocking or Flattening Filter:

The VNIR 400H comes with an Order Blocking Filter.
These filters are used to remove any second order
disturbance into longer wavelengths derived from
the shorter wavelengths.

This filter is checked, installed, and tested by our
expert lab technicians.

The Cables and Interfaces:

_ The VNIR 400H utilizes a standard USB cable to power the
g motor control assembly and as a separate camera
interface/power supply.

USB

= o PhiLlumina, LLC : 45 Hardy Court #355, Gulfport, M5 39507
iLumina
http://www.philumina.com Ph: 228-363-4048 info@philuminag.com
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Components VNIR400H

Lunch box or Tower Computer:

Your system will either come with a lunchbox computer or a
tower computer with monitor, keyboard, and mouse. In this
computer will be the Ethernet, USB 2.0, or frame grabber
card/interface that will be needed to interface the camera
system to the software system. This computer will come

installed with PhiLumina’ award winning software. ENVI
analysis software is optional. If ENVI is ordered with the
system, it will also be installed and tested on the system. All Lunch Box Computer
the appropriate files such as wavelength and pixel correction
files will be loaded onto the system and tested as well by our

expert technicians.

Laptop Computer:

. Tower Computer
Some of our turnkey system products can now be used via

a laptop, without an external interface. Our VNIR400H &
E, our SWIR900 (T-FPS1700) series and our SWIR2500 (T-
FPS2500) series can now be used via a laptop computer.

NOTE: See the documentation for the computer that

comes with this system. All computer documentation Laptop Computer
from the manufacture can be found in the documentation
packet that came with your system.

' = & PhiLumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
iLumina
http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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Components VNIR400H

White Reference Panel:

Your new PhiLumina's system comes with one 99% NIST

traceable white reference panel. This panel is use for purpose

of percent reflectance calibration of the acquired sensor data.

THEMIS’ software utilizes two types of calibration function NIST Traceable
routines that use the data acquired with this reference. At el
NOTE: See the documentation for the reference panel that
comes with this system. All reference documentation from the
manufacture can be found in the documentation packet that
came with your system.

Objective/Fore Lens:

Your new PhiLumina’ system comes with one fore- lens (unless
others were purchased with the system). This lens will be a ¢-
mount lens color balanced specifically for the spectral range for
the product that was purchased. These lenses come in a series
of different focal lengths. For example, the standard focal length

C-Mount Lenses

that is typically packaged with the Phllumina VNIR systems is a
23 mm c-mount lens color balanced for optimal performance
between 400 and 1000 nanometers.

NOTE: See the documentation for the lens that comes with this
system. All lens documentation from the manufacture can be

found in the documentation packet that came with your system.

' = & PhiLumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
iLumina
http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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System Setup VNIR400H

The Camera connections: VNIR 400H Series

The picture to the left shows the power
cable being plugged into the VNIR 400 H
Hyperspectral System. This cable must be
plugged into a standard electrical power
source. This cable powers the motor
control, the cooling fan, and the digital
camera. Listen for the fan motor to ensure
the system is powered up — you should
hear it running. If you don’t, check your
cable connections.

To the left is a picture of the USB
motor control communications cable
being plugged into the VNIR 400H
Hyperspectral System. This cable
controls the motor control system.
This USB-2 cable can be plugged into
any active USB-2/3 port.

-

i & . Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
WhiLumina
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System Setup

To the left is a picture of the USB
digital camera communications
cable being plugged into the VNIR
A400H Hyperspectral System. This
cable cantrols the digital camera.
This USB-2 cable can be plugged
into any active USB-2/3 port on
the computer.

To the left is a picture of the Halogen Lights
mounted on the backside of the motor control box.
Insure that the lights are above the bottom of the
lens and the path of their light crisscrosses across
the target area. The lights must be plugged into a
DC power converter.

To turn on the lights switch the MFI Power Supply
on, and then turn the “DC Adjust Knob” counter
clockwise all the way to the left. Then turn on both
Halogen lamps. Finally, turn the “DC Adjust Knob”
clockwise to the right until the “Voltage Reading”
dial is at 12 Volts on the MFJ Power Supply.

e & . Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
WhiLumina
http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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NUVNIR 350

Set Up and Operating Instruction
This manual is for use with PhiLumina, LLC's Hyperspectral Imaging Systems product line. It gives an
overall view and process of the hardware, software, and its use.




Components NUVNIR350

The Themis’ HSI system hardware is made up of the following components for the Basic Setup:

.

The Hyperspectral Sensor Head & Scanning Assembly
The camera & Filters

The cables and interface

The high powered computer

The fore lens

The white Reference Panel

Halogen Lights with DC Converter

The Hyperspectral Sensor head and Scanning Assembly:

The camera mounts to the scanner
assembly via a c-mount connection
between the camera and the optical
mount. The two are bridged together
by a rotating mounting bracket that is
locked down during assembly and
mounted inside the Motor Control box.

AiLumina

The scanning assembly is comprised of the
spectrograph, motor, patented focal plane
scanner, and c-mount attachments for the fore
lens and other mounting. The motor is found
at the front of the assembly above the focal
plane scanner and the motor control module is
located at the top of the scanning assembly
right above the optics assembly. This is all
covered & protected hy an assembly cover,

Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507

FOMWARD THahsins
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Components NUVNIR350

Order Blocking or Flattening Filter

The UVNIR350 comes with an Order Blocking Filter. These
filters are used to remove any second order disturbance
into longer wavelengths derived from the shorter
wavelengths. This filter is checked, installed, and tested by
our expert lab technicians.

The Cables and Interfaces:

The VNIR 400T utilizes two “Camera Link” cables (that \
g plugs into the Frame Grabber Card on the computer) to

transmit image data; a standard USB cable to power
the Motor Control Assembly; and two standard Power
Cables (on both the Motor Control Assembly and the
Digital Camera).

Camera Link Cable
USB Cable

ke 5 . Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
WhiLumina
http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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Components NUVNIR350

White Reference Panel:

Your new Philumina's system comes with one 99% and one
12.5% NIST traceable white reference panel. This panel is use
for purpose of percent reflectance calibration of the acquired
sensor data. THEMIS' software utilizes two types of calibration
function routines that use the data acquired with this reference.

NOTE: See the documentation for the reference panel that
comes with this system. All reference documentation from the
manufacture can be found in the documentation packet that
came with your system.

Your new PhiLumina's system comes with one objective/fore- lens
(unless others were purchased with the system). This lens will be in
most cases a c-mount (for our UVNIR350 and M42 mount ) lens
color balanced specifically for the spectral range for the product
that was purchased. These lenses come in a series of different
focal lengths. For example, the standard focal length that is
typically packaged with the PhiLlumina's VNIR systems is a 23 mm c-
mount lens color balanced for optimal performance between 400
and 1000 nanometers (the UVNIR350 would be, etc).

C-Mount Lenses

NOTE: See the documentation for the lens that comes with this
system. All lens documentation from the manufacture can be
found in the documentation packet that came with your system.

M42 -Mount Lenses

. Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
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System Setup NUVNIR350

The Camera connections: THE UVNIR 350 Series

The top arrow to the left shows the
Power Cable being plugged into the
VNIR 400T Motor Control Assembly.
This cable is plugged into a standard
110/220 voltage electrical power

source,

-~

Power Cable
The second arrow to the left shows
the USB Cable being plugged into the
Motor Control Assembly. This cable
controls the movement of the slit and
must be plugged into an active USB-2
or USB-3 port on the computer.

The second image to the left shaws
the “silver colored” pco.edge Power
Cable that plugs into the top of the
digital camera next to the two Camera

Link Cables. This cable is plugged into
a standard 110,220 voltage electrical

power source.

Power Cable

The third image on the left shows the
pco.edge “On/Off” Switch on top of
the digital camera. This switch must
be turned on before you initiate the
HyperVisual Software program. If itis
not, you must exit out of the program
and restart the program for the
software to recognize the camera.
When not in use, we recommend you
turn this switch off to maximize the

life of this camera.

i & . Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
WhiLumina
http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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System Setup NUVNIR350

The Camera connections: THE NUVNIR 350 Series

The Image to the left shows the two
Camera Link Cables being plugged into
the top of the pco.edge digital camera.
These two cables transmit data to the
computer from the digital camera and
must be plugged into a Frame Grabber
Card (Camera Link Card) on the computer.

It is important to note that the two cables
are labeled either “A” or “B.” Make sure
you plug the “A” Cable into the “A” Slots
on both the camera and the computer;
and that you plug the “B” Cable into the
“B" Slots on both the camera and the

computer.

To the left is a picture of the Halogen Lights
mounted on an Olympus Bracket on the
backside of the Motor Control Assembly.
Insure that the lights are above the bottom
of the lens and the path of their light
crisscrosses across the target area. The
lights must be plugged into a DC power
converter.

To turn on the lights switch the MFJ Power

Olympus Bracket " z Supply on, and then turn the “DC Adjust
| = ; Knob” counter clockwise all the way to the

left. Then turn on both Halogen lamps.

. | o Finally, turn the “DC Adjust Knob" clockwise
Halogen Light to the right until the “Voltage Reading” dial

is at 12 Volts on the MFJ Power Supply.

. Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
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HyperMicroscopy

PhiLlumina's HSI systems are built to be multiplatform
and adaptable to macro and micro systems.
Attachments to microscope mounts via single and
multiple standard ports and custom mounts, allow the
end-user to use our award winning portable systems
with the ability to move the system core from one
research setting to another.

Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507
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Technical Support

PhiLumina, LLC holds pride in their product, services, and support. If you are in need of support,

have a question, or just want to give your input, contact one of the follow:

For software support: softwaresupport@philumina.com

For Sales Support: techexec@philumina.com

For General Support: info@philumina.com or 228-363-4048 or write to:

PhiLumina, LLC

45 Hardy Court #355 Gulf-
port, MS 39507 http://
www.philumina.com

Philumina, LLC : 45 Hardy Court #355, Gulfport, MS 39507

http://www.philumina.com Ph: 228-363-4048 info@philumina.com
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Chapter 1: Introduction

PHILUMINA® is a GUI-based software package that allows the end-user to communicate with
and control hyperspectral imaging systems, scanning motors, cameras, and other PHILUMINA
turnkey devices. The software is designed for Windows XP, and Windows 7 platforms (32 & 64
bit Operating Systems), it converts scanned images obtained from our hyperspectral systems into a
single image data [ormat that contains spatial and spectral information [or every pictlure element in
the image. It is a well tested stable platform that is designed with the end user in mind. It has a
number of acquisition and pre-processing routines; as well as screen enhancements that can then
be run on these hyperspectral images and finally ported into off-the-shelf image processing
packages.

PHILUMINA © is the heart of the PHILUMINA'S core product line. It was originally derived
[rom the NASA Commercial Space Program and was part of the technology inducted into the
NASA Space Foundation’s “Technology Hall of Fame”. The software contains a user friendly
approach while not losing the technological prowess of the functionality needed to acquire,
process, normalize, save, catalog, and verily quality data. PHILUMINA ? locates the hardware
that has been programmed into its functionality, interacts with that hardware, acquires data sets,
previews images, and saves data in formats such as Band Interleave by Line (BIL), Band
Sequential (BSQ), LAN and several other industry formats. The image display can also be saved
out to standard image formats such as Bitmap (bmp), JPEG (jpg), etc. PHILUMINA ® offers
powerful and traditional functionality such as normalization routines (including its pixel-by-pixel
calibration methodology), noise removal functions, statistical output, ENVI headers, time stamp
information, error logging, batch processing, project management, and many other [eatures that is
needed to capture and retain quality and accurate data from raw data set to data ready for analysis.

PHILUMINA © is easy to use and offers a very simple format for the end user. All functions can
be found in tab and push button format and in traditional menus on the top menu bar.
PHILUMINA ® is being used worldwide by a wide variety of researchers in use with their
PHILUMINA'’S hyperspectral imaging systems and for stand-alone image verification.

Ilu Teasing imwcru v

is classified by wavelength into TEp | Xnp | OV | Microwave F-\I| H Long radio waves
electrical energy, radio, —

Microwave, Infrared (IR), ™ e i ™ et TR w0 P @ im
the visible region we perceive as B e Iru'tm‘“anl;ng.ﬂlur—'

light, Uitraviolet (UV), X-rays . Visible Spectrum e

i i e

& Sn Lol oo

Spectroscopy can detect a much wider region of the EM spectrum than the visible range of
400 nm to 700 nm.
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Hyper spectral imaging records many discrete spectral ‘slices’ of reflected energy across the visible
and near infrared portion of the spectrum, resulting in numerous images of a given larget.
Individual spectral 'slices’ contain unique information about the imaged object.
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“Slicing” spectral information obtained from a target into hundreds of discrete images that contain

reflective, absorptive and refractive properties unique to target as a function of wavelength. These

properties are used to detect and identify unique signatures from the target. Such as a wound

shown here:

Hyperspectral
nda (™ e

Spectral Signature

e

Refectonce

wavelengin (nm)

The PHILUMINA ® software provides user-friendly tools such as:

= Live Preview — this feature allows the end user to focus the system on the target and get a
feel for where the target is in relation to the system.

* Escape Function During Scan — this feature allows the end user to cancel the scan or
routine. The system then resets itself back to the original settings.

* Geometry Control — This is a built in feature that controls the system/scan to retain
excellent geometry in reference to the target being scanned.

* Camera Controls — the software has a series of controls throughout that controls the
specific camera that is being used and offers key features from offered with that
camera.

= Region of Interest Acquisition Controls - for most of the newer cameras, PHILUMINA
can be set to capture wavelength and spatial data via a region of interest that is chosen by
the end user. There are several controls including a resolution wavelength width selection
feature.

* Real-Time View During Acquisition — the software allows the end user to see what they
are scanning. If it seems that the target is not in the right area, the end user can cancel the
scan and reset for a new scan.

= Image Display — the image display allows the end user to see monochrome, RGB,
wavelength specific, band specific, and curve data on an image display. The display
features toolbars, functionality, and interactive tools.

= Image Information Retrieval - the software provides [unctions [or statistics, curve
retrieval, and header information.

* Normalization/Calibration — the software calibrates data via percent reflectance.
Radiometric calibration routines will soon be added.

= Noise Removal — There are two types of noise removal that remove the noise in the
spectral dimension. Traditional Mean Calibration and newer Linear Regression Models.

* Image Statistics — the software allows the end user to derive statistical information from
the saved and acquired data.

* Pixel Property Tool — the pixel property tool can be used to analyze point curve data. A
curve is gencrated for a particular point sclected by the end user within the image
display.

= Batch Processing — the software has a batch processing tool that can process acquired data
and log errors without stopping the process.
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header so that the work is done for you to port the saved data from the software directly
into ENVL

* Project Management Tool — this tool allows each end user to save their own settings for

the system so that their projects stay intact for each specific user. There is also a note
logging system in the header tool for each image.
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Chapter 2: Installation

The installation process is rather simple for PHILUMINA ® the software is loaded in a pre-
selected folder that is created for you, unless you (the end-user) changes the path where you would
like the software to be installed. Friendly pop-up messages will be displayed, if specific programs
or additional features need to be shut down or pre-loaded. All of the pre-loaded features can be
found on the PHILUMINA ¢ installation CD.

To install PHILUMINA “:
1. Close all programs.
2. Tnsert the PHILUMINA © Installation CD into your CD-ROM drive. If AutoPlay
is enabled on your system, the installation will begin automatically and you can
skip steps 3 and 4.
3. From the Start menu, click on Run.
4. Type “D:\setup” (Substitute the appropriate drive letter of your CD-ROM for D).

Release: PL-0004-2 http://www.philumina.com /
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Chapter 3: Getting Started

To start PHILUMINA ©:
From your Start menu, select Programs, then select PHILUMINA ® or double
click the PHILUMINA ® shortcut on your desktop.

PHILUMINA ® will first scan through the sequence of hardware detection and then will load the
main screen on the computer display.

o

Figure 3.1: The main PHILUMINA® screen

Release: PL-0004-2 http://www.philumina.com Page |37



%ﬁumina - Software Manual

Opening a File The file extension for PHILUMINA® is (*.hyp). However, the software also
reads ENVI (*.img), (*.1an), and several other format files. A windows file selection (windows
file explorer) dialog box will appear for you to select your *.hyp file to display in the image
window for PHILUMINA®

To open an image file:
Select File > Open from the main menu and navigate to the file you want to open.
Then click Open.

G Froject Devies Admin Imsge Window Help

e

Figure 3.2: Opening an image file
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PHILUMINA® remembers the last 5 files you opened, and makes it simple to reopen them by
placing them in the Recent Files submenu.

To open a recent file:
Select File > Recent Files from the main menu and click on the file you want to
open. The full path to the file is shown in the status bar at the bottom of the main
window.

Recent Fies * E:\Calibeata| Traning_20010608_Calo9_D0OL hyp
] B cox | E:{DataTraning_20110608_000L yp
E:\Cafibrata | Training_20110608_DC_0001. hyp
E:\Data) Training_201 10602_0007 hyp
E-\DistalTraiing_20110602_0005.hyp

Figure 3.3: Opening a recent file
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Saving a File

To save an open file:
Select File > Save As from the main menu. Navigate to where you want the file
saved and type the name you want the file saved as. Then click Save.

Note: PHILUMINA® automatically saves files that have been modified. This
feature is mostly used for renaming a file or for making a copy of it.

Closing a File

To close an open file:
Select File > Close from the main menu while the file you want closed has

window focus.
Or

Click on the Close button in the upper right hand corner of the window to be
closed. It appears as an X inside of a box.

Exiting PHILUMINA®

To exit PHILUMINA®:
Select File > Exit from the main menu.
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Chapter 4: Setting Up Projects

PHILUMINA® incorporates the use of multiple projects for differing settings and hyperspectral
camera systems to be run from the same system. Each project can be configured with default set-
tings so that changing from one group of settings to another is as simple as changing the current
project. Each project can also be set to operate a different hyperspectral camera system, making it
possible to run multiple cameras from the same computer.

By utilizing the project manager feature, the end-user can save time in saving specific settings that
they want to save and come back to later. This allows a large group to keep settings for each spe-
cific end-user and/or project. This project manager saves setting for the camera, motor control,
displays, components, and user-specific settings (save ENVI header, Use Large Icons, etc.). The
project manager also keeps track of specific and important files such as wavelength files, pixel
correction files, etc.

Project Manager

The Project Manager can be accessed by opening the Project menu and selecting Manage

Projects. The manager is broken into categories by tabs along the top of the window:

» Project Settings: Settings that apply globally to the project and that do not belong to any
of the other categories.

» Display Settings: Settings that affect the way images are displayed. Contains settings for
particular histogram stretches, which wavelengths to display by default, and the color of the
application’s background.

» Camera Settings: Settings that determine what camera system is associated with the

project, as well as default settings for image acquisition.

Motor Settings: Settings that determine what motor system is associated with the project,

as well as default settings for image acquisition.

Stage Settings: Settings that determine what fore-optics type is associated with the project.

v

v
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Fle  Project Devices Image Admin  Window Language Help

Dipy | Cavem | MawhSiage | Copir

[ tewPrgeat |
| Delete Project |

Figure 4.1: The Project Management window: Showing “Project Settings " Tab

Project Settings

This tab allows you to create new projects, edit the name of existing ones, or to delete a project

completely. You can also set some general properties for the project as a whole.

Project Name: Select the name of an existing project that you want to modify.

New Project: Click this button to create a brand new project.

Copy Project: Click this button to create an exact copy of the project that is currently

selected.

Edit Name: Allows you to change the name of the currently selected project.

Delete Project: Completely deletes the project from the application’s database.

Default Capture Directory: This sets the folder where captured images are (o be saved by

default. Images can be saved to other locations by manually entering the path while in the

Image Capture window.

» Directory for Calibration Files: This sets the folder where calibration files (99%
reflectance and Dark Current) are to be saved by default.

» Auto-Save ENVI Header: Checking this box results in a header file for the ENVI® image
analysis program being created when an image is captured.

YVVV YVY

Release: PL-0004-2 http://www.philumina.com Page |42



Fumina - Software Manual

Capiure Window Defais
Displayed izvelengh

7] s Large Icons (Changing this will enky affect new windows|
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Figure 4.2: The Project Management window: Showing “Display Settings ™ Tab

Display Settings
This tab displays the settings that will affect the way images are displayed both during pre-
view/capture and when they are loaded from a file. It also contains settings for the way the
application itself is displayed.

» Main Program Window:

» Background Color: This will allow you to change the background color of the
application’s main window.

» Display Window Defaults:

* Displayed Wavelengths: Each of these settings (Grey, Red, Blue, and Green)
determines what wavelength of the image is to be displayed by default when an image
is loaded from a file.

= Histogram Stretch: This is the default type of streich to be used when an image is
loaded trom a file.

» Capture Window Defaults:

= Displayed Wavelength: This setting determines what wavelength will be displayed on

the screen during a preview / capture.
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* Histogram Stretch: This is the default type of stretch to be used for the image
displayed on the screen during a preview / capture.
* General: The only current general function is for the allowance of larger

File Project Devices Image Admin Window Language Hep

md_ | Dmey | e | WawdSam | Cwae |

Dievica: Infummation
L
Hone:
FuusflylUSB 157 Edit Name
S8 ¢ - :

| Delete Camer
¥EVA 35 3201879
Mt Rasolution 1280x 1024
Vizvelength File Hare
GLPFile Mone:
Pinel Comectan File Hane

| Actrete Pixel Corrociion

Figure 4.3: The Project Management window: Showing “Camera Settings " Tab

Camera Settings

This tab displays the settings for the camera that is attached to the project.
» Device Information:

= Camera Name: This contains a list of all the cameras that are currently stored in the
database. The “Present” checkbox beside it will be checked if the currently selected
camera is recognized by PHILUMINA®.

* Model: This displays the model of the currently selected camera.

= ID: This displays the ID of the currently selected camera.

* Spectrum: This displays what spectrum range the currently selected camera has.

* Max Resolution: This displays the maximum resolution of the currently selected
camera.

* Wavelength File: This setting is for automatically attaching a wavelength file to an
image as its being captured.
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* Activate Pixel Correction: Checking this will cause the camera to perform pixel
correction on any invalid pixels in its CCD, provided that the camera supports this
feature.

* GCP File: This setting determines what file is to be used by default when performing
GeoCorrection on an image taken by the currently selected camera.

* Pixel Correction File: This setting determines what file is to be used by default when
performing Pixel Correction on an image taken by the currently selected camera

= Edit Name: Clicking this allows you to edit the name of the currently selected camera.

* Delete Camera: Clicking this removes the currently selected camera from the
database.

File Project Dedces Image Admin  Window |anquage  Help

Figure 4.4: The Project Munagement window: Showing “Molor & Stage™ Tab

Motor & Stage Settings
This tab displays settings for the motor that is attached to the project.
» Device Information:

* Motor Name: This contains a list of all the motors that are currently stored in the
database. The “Present” checkbox beside it will be checked if the currently selected
motor is recognized by PHILUMINA®.

»  Model: This displays the model of the currently selected motor.

= ID: This displays the ID of the currently selected motor.

(The next two features are dependent on the “Stage Settings” tab information)
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* Centered At: This displays where the center motor position is set for the given
parameters.

* Movement Range: This displays the set range of movement for the currently selected
settings in the “Stage Settings” tab.

» Default Movement Settings:

* Top to Bottom Movement: This sets the motor to travel from its top position to its
bottom position during a capture. This is mutually exclusive with Bottom to Top
Movement.

* Bottom to Top Movement: This sets the motor to travel from its bottom position to its
top position during a capture. This is mutually exclusive with Top to Bottom Move-
ment.

» Spectrograph:
* Model: This list contains types of spectrographs. This feature is mainly for Header

Information.
» Focal Plane Scan-
ner:
= Model: This contains a list of all the focal plane scanners that are currently stored in
the database.

* Movement Limits: This displays the physical range of movement for the currently
selected focal plane scanner.
e Lens
e Type: This contains a list of lens mount types used
e Vignetting Range: This displays the physical range of movement allowed before
distortion of the outer range of the lens plane affects the data input this is a function of
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Figure 4.5: The Project Management window: Showing “Capture” Tab

Capture Settings
This tab displays settings for the fore-optics that are attached to the project.

» Default Capture Settings:
» Spatial Binning: This allows you to set what spatial binning the camera will default to
when the Image Capture window is opened.
= Spatial Resolution: This displays the spatial resolution of the currently selected
camera based on the spatial binning setting.
= Spectral Binning: This allows you to set what spectral binning the camera will default
to when the Image Capture window is opened.
= Spectral Resolution: This displays the spectral resolution of the currently selected
camera based on the spectral binning setting.
* Lines to Capture: This is the default number of lines to capture per image acquired in
the Image Capture window.
* Exposure Time: This is the default exposure time to use when capturing an image in
the Image Capture window.
= Activate Pixel Correction: Checking this will cause the camera to perform pixel
correction on any invalid pixels in its CCD, provided that the camera supports this
[eature.
» ROI (Region of Interest) Capture Settings: The display boxes in this area of the project
manager are only details for what is set during ROI setup from the capture/Preview
window that is then saved to the project. These settings cannot be changed from the
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project manager; only from the user settings in the acquisition/capture/preview window.
NOTE: These ROI features are not available in all of PHILUMINA, LLC products as of
yelt.

¢ Selective Capture: This displays that the function has been set by the user in this
project for selective capture.

e ROI: This button shows that the Draw ROI feature is set by the user for this particular
project, as opposed to the Wavelength Selective List Feature.

¢ ROI Selection: This set of information shows what features in the ROI function has
been set by the user.

¢  Wavelengths: This button shows that the Wavelength Selective List Feature is sct by
the user for this particular project, as opposed to the Draw ROI Feature.

¢ Wavelength Selection: This allows you to set what spectral binning the camera will
default to when the Image Capture window is opened.

e Full Spatial Width: This check box shows that the end user has chosen to use the en-
tire useful range of the X dimensional spatial data from the camera. If the Full Spatial
Width is not used; then the spatial extent will show the new boundaries.

e Specify Wavelength: This feature shows what wavelengths were chosen from the
Wavelength Selective List for this project.

e Spectral Extent: This shows the extent of the spectral ranges based on the user deflined
selection for the camera.

Y

Motor Capture Settings:

* Movement is Centered: Checking this will cause the motor to center the capture area
inside its movement range during a capture.

* Movement is Centered: Checking this will allow thc motor to move during capturc.
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Chapter 5: Image Display

Image files opened into PHILUMINA® are displayed in the Image Display window. This
window contains numerous controls related to manipulating how the image is viewed, and also
includes a toolbar that allows you to perform various manipulations of the image file itself.

File Projet Dovices Image  Admin Window  Language Help

Colm: 182 Row: 15 SR O161%

Figure 5.1: The Image Display window

Display Control Panel

The display control panel is located on the left side of the Image Display window. It contains the
controls used to modify how the image is viewed. The various aspects of viewing the image that
can be changed are:

» Display Type: The image can be displayed in either a Grey Scale output or in a RGB Color
output.

» Band/Wavelength: The actual band/wavelength that is displayed can be changed to any of
those within the range of the image.

» Orientation: The image can be displayed using either a spatial orientation or a spectral
orientation.

» Reverse Display: The image can be reversed along both the horizontal and vertical axes.
This only affects the current display, and not the actual image file.
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Display Toolbar

The display toolbar is located at the top of the Image Display window. It contains the controls
used to perform various manipulations of the image file, as well as several controls that display
information about the image.

E=  TEHLIEE A=BuEB=8

Figure 5.2: The Image Display Toolbar

The various operations that the toolbar can be used for are:

» Show/Hide Control Panel: Toggling this button of the toolbar changes the visibility of the
control panel.

» Close All Child Windows: This button will close all windows that have been opened [rom

the Image Display window at once.

Image Information: This button will bring up the Image Information window, displaying

information about the image file.

Import Wavelengths: This button is used to add wavelengths to a file that doesn’t have

them, using a grc—built wavelength file.

Create ENVI™ Header: This button will create a header for the image file so that it can be

used with the ENVI® image analysis program.

» Histogram: This button displays the Histogram window, allowing manipulations to be

made to the histogram of the current image.

Calculate Statistics: This button generates a statistics file for the image file, giving

information such as the min/max values of the image and the standard deviations.

Bad Pixel Selection Function: This button is used to help find saturated and dead pixels

found on several types of cameras. The output is used with the Pixel Correction Func-

tion.

Export Image: This button allows you to export the image currently displayed into either a

* bmp, *.jpg, *.png, or *.tif file formats.

Flip Horizontal: This button causes the data in the image file to be flipped along its

vertical axis, causing the left and right sides of the image to be swapped.

Flip Vertical: This button causes the data in the image file to be flipped along its

horizontal axis, causing the top and bottom sides of the image to be swapped.

Subset Image: This button performs the process of sub-setting the data set in the spatial

and/or spectral space.

Calibrate: This button performs the process of calibrating the image from raw data values

into percentage of reflection values.

Noise Removal: This button is used to remove the various noise types from the image file

using one of several methods.

Dark Current Noise Removal: This button is used to remove the electronic noise from the
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Y

Geocorrection: This button performs the process of geometrically correcting the data
within an image file using a pre-built geocorrection file.

Pixel Correction Function: This button is used to correct saturated and dead pixels found
on several types of cameras.

v

Display Image

The Display Image fills up the remaining space on the Image Display window. It shows a visual
representation of the data read in from the image file. Using the mouse in this image will enable
several tasks Lo be performed:

» Position Tracking: By moving the mouse pointer over the image, the column, row, and
value listings in the status bar are updated for the current position in the image.

» Position Locking: By left-clicking inside the image, a crosshair will be overlaid on the

image, intersecting at the point clicked. This also locks the column, row, and value listings

in the status bar at the values for that point in the image.

Spectral Curve: By left-clicking inside the image and locking the position, a spectral

curve can be performed at that point. Right-click inside the image to bring up the context

menu, and choose Spectral Curve. Up to 6 different spectral curves can be performed on

the image at a time.

Zoom: By left-clicking and dragging a selection box in the image, the select area can be

magnified. Right-click inside the image to bring up the context menu, and choose Zoom.

Then choose the desired magnification.

Clear: By right-clicking in the image and then selecting Clear in the context menu, a

Position Lock can be unlocked, or any selection boxed will be removed.

‘f

‘1’

‘?’
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Chapter 6: Image Capture

PHILUMINA® is capable of controlling several hyperspectral camera systems and can use these
camera systems to record hyperspectral imagery of selected targets. This capacity of the
application is handled in the Capture Image window.

# Default Project
Erii®-® LE
| Stalus |Imags | Intervals | Devices
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BaseFie Mome | |
Image Captwe Diecioy

CADNCHME ~ 1M lsetl NCAL §~1\Temp 6]
Calibrabon File Di
CADOCUME~14UseLOCALS " 1\Temp |

Cizneral
Frames ho Caphue 1

Masimum Frames T s
Caghure Number
Cophured Fromes
Ponding Save:

Caphure Duration

Time Remaining

Devices
Cameall  |PuskydED
Sercsor Tempessture

Motce I [Hone . ]

Figure 6.1: The Capture Image window: Showing the “Status” tab

The Capture Image window is divided into the following tabs: Status, Image, Intervals and
Devices.

The Status Tab:
» Files: This group has several feature settings that defines where the output will be saved
and what its naming convention will be.

Base File Name: This is the name that you give for a given acquisition set. The name
will remain the same until you change it. The software will automatically append a
date and number sequence to each file saved under that naming convention.
Image Capture Directory: This path line contains the directory for where the
acquired data is saved. This is set in the Project Management Database. One can
change the path by clicking on the button at the right of the directory space.
Calibration File Directory: This path line contains the directory structure to where
the calibration data sets will be saved.
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» General: This group performs two functions.
Frames to Capture: This is where the end-user sets the lines that are to be captured
within the maximum range.
Maximum Frames: This is a display of the maximum number of lines the camera
system can capture in one image. This is determined from the range of the focal plane
scanner of the camera if a motor is used, or from the amount of storage space on the
hard drive if no motor is used.
This tab gives the status of the capture and save status and gives an estimation of the
time left for each and for how long the capture should take. There is also a Sensor
Temperature info box for monitoring purposes.

» Devices: This group pertains to the Camera specifications.
Camera ID: This identifies which camera will be used during the capture sequence.

Eri®-® LHE
| Statue | Image | irsesvals | Devees|
| - Exposure Time jms)

50

L1 3
Binning & Resolution

Spatial EREA
Specwal 1 = 1024

Galartiva Caphre
Select ROI Select Wavelengths

| Position

Figure 6.2: The Capture Image window: Showing the “Image” tab

The Image Tab:

» Exposure Time: This determines the length of time (measured in milliseconds) that the
camera “ccd” will be exposed per line captured.

» Binning and Resolution: This group contains the information and settings for the binning
of the camera and the resolution associated with the binning settings.
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Spatial Binning: This is a list of the various levels of spatial binning the camera
system supports.

Spatial Resolution: This displays what the spatial resolution of the image will be
given the current spatial binning.

Spectral Binning: This is a list of the various levels of spectral binning the camera
System supports.

Spectral Resolution: This displays what the spectral resolution of the image will be
given the current spectral binning.

Fri@e-® LA
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Start Time: _
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- caphured

Inierval Type

Figure 6.3: The Capture Image window: Showing the “Intervals " tab

Y

Capture Multiple Images: This feature is for use in the full frame mode for a camera

when one wants to take images in a time sequence.

Delay between start of each Capture: This is the time delay for the amount of time that the

system waits between each of the image captures/scans.

» Inter-frame Delay Time: This adjusts the time between each actual frame captured. This is
used in full frame mode not push broom. This means that a camera is being used without a
spectrograph.

» Include Delay between Frames Captured: This is a check box that engages the Interframe

delay time [eature.

‘J‘!
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Eriie-® iLd
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Figure 6.4: The Capture Image window: Shawing the “Devices™ tah

» Enable Motor (Move during Capture): This determines type of scan and how the motor
will move during the capture. The different selections are:

Spectral Image: Means that you are in push broom mode using a spectrograph.
This means that you are producing a spatial and spectral data cube.

Spatial Image: This means that you are using a full frame camera that does not
have a spectrograph. There is no spectral feature to the data.

Top to Bottom: The motor will begin in its uppermost position and move towards
it’s lowermost position during the capture.

Bottom to Top: The motor will begin in its lowermost position and move towards
ils uppermost position during the caplure.

Centered: The motor will move to its center point, and will determine the range it
needs to capture the image, then move according to whichever of the previous 2
selections are set.

Image Capture Toolbar

The toolbar is located at the bottom of the Image Capture window. It contains controls for setting
and performing various actions with the camera system.
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Figure 6.4: The Image Capture Toolbar

The various actions the toolbar can be used for are:
Show/Hide Sidebar: Used to hide the sidebar data below.
Activate Preview Mode: Used (o see a real-time display of what the camera system “sees”.
Pause Preview Mode: Used to pause the preview window. Clicking it again will restart
the preview.
Begin Capture: Begins the image acquisilion process.
Sri @ o LW

Capture Image

Capture Calibration Image

Capture Dark Current Image

Y V¥V VY

Y

By pressing on the arrow next to the green capture button the end-user can choose what
type of data he/she would like to acquire.

End Image Acquisition: Stops an active preview or capture process and rescts the system.
Show Histogram for Current Image: Opens the Histogram window for adjusting the
display of the image during capture or preview.

Save Project Defaults: This button allows the end-user to change settings in the dialog and
tabs to the current project settings.

Y Y

Y
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Chapter 7: Image Processing
All image processing creates new image files, leaving the original image file unchanged.

Calibration

Calibration takes the raw data captured by the camera system, and using a linear interpolation
algorithm, processes that data into a percentage of total reflection.
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Figure 7.1: The Calibration settings window
» Use Calibration Cubes: This setting uses two different images to perform the calibration
on the processed image. The Dark Current Cube is an image taken while the camera sys-
tem 1s exposed to no light at all. This records only the electronic noise from the camera.
The 99% Cube is an image taken of a 99% reflection panel.
Use Reference File: This setting is for when there is not a full reference image to cover the
entire field of view. The full field of view would need to be covered in order to use the
pixel-by-pixel calibration methodology in PHILUMINA.
Creating the Reference File:
As seen in the Image example below, a file must be created containing the reference mean
data needed to calibrate the image using prior art calibration standards, sometimes referred
to as Mean/Average linear calibration to percent reflectance.

Y

Y
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Figure 7.2: The Mean Calibration settings window

This window is generated by holding the left mouse button down and dragging it across the Region
of Interest (ROI), let go of the left mouse button, pressing the right mouse button inside of the
newly created ROI and selecting Create Reference File from the drop down menu.

The number typed in the Percent Reflectance of Current Image box should be that of the
percentage of the given target reference. For Example: 0 would be for Dark Current and 99 would
be for a 99% reference panel.

Save the calibration reference file by clicking on the button on the left hand side of the box labeled
Calibration Reference File. This will open a standard Windows save box. Enter the name of your
reference file and click OK.

Repeat this for your Dark Current File. Choose the same file for all reference material that belongs
in that file to calibrate data associated with those reference values. When you go to save the Dark
Current to the file that you already saved the 99% data too, it will ask you if you want to overwrite
the file. Choose YES. The file will only append the data into the file.

2 CALIBRATION ROUTINES

Calibrate (Pixel By Pixel):
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Figure 7.3: The Calibration settings window (Calibration Cubes Setting)

Pixel-by-Pixel calibration uses full images of the reference file and Dark Current to
calibrate/normalize the data to percent reflectance.

Start by clicking the select button to choose a dark current file. The new PHILUMINA calibration
file is a 2 band image that is a collection of dark current samples. If the dark current file that you
have is from an earlier version of PHILUMINA software, you will need to open the dark current
file in PHILUMINA first and then select convert to dark current from the Admin menu drop down
list. This will then create a file with the [DC] extension on the end of the file. This can now be
used in earlier versions of PHILUMINA software. Next you will choose whether you want to use
calibration cubes or a reference file. If you want to use a reference file, move to the next section.

Click on Add to select the percent reflectance file. The standard is usually 99%. However, some
users prefer linear regression using more than one % standard target. This percentage will be set in

the file header when collecting a reference file during capture reference target procedure.

Once you have selected your files, press OK and the software will now calibrate your file to
percent reflectance.

Calibrate via Mean/Average Reference:
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Figure 7.4: The Calibration settings window (Use Reference File Setting)

The Use Reference File routine allows the end user to use a calibration file (see creating reference
file) when a full image reference file is not available.

Click the select button and choose a dark current file, this is file is not needed if you already have
the dark current data in the reference file. Now click Add. A standard Windows box will open for
you to select the calibration XML file to calibrate your data. Click OK.

Noise Removal

Noise removal uses certain algorithms to manipulate the data in and image in order to remove the
digital noise from the image. The Linear Regression and Savitsky-Golay algorithms are
supported by PHILUMINA®.

Subset Image

The subsct image process allows the user to define a particular region of interest in an image and
create an entirely new image file using that Region of Interest. Both the upper and lower bounds
for bands, rows, and columns can be set, with the new image file created from the resultant
inclusive selection.
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Flatten Image

“Flattening” an image is the process of averaging all of the bands of the image together, creating a
single spectral response for each pixel of the image.

Flip Horizontal

The horizontal flip process flips the image data along it’s vertical axis, creating a horizontally
mirrored image.

Flip Vertical

The vertical flip process flips the image data along it’s horizontal axis, creating a vertically
mirrored image.
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Chapter 8: Batch Processing

PHILUMINA® is able to perform many image processing functions as a single batch process.
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Figure 8.1: The Batch Processing window

The controls in the basic Batch Processing window are:
» Load Batch: Loads a batch setup that has been previously saved to a file.
» Save Batch: Saves the current setup to a file that can be reloaded at a later time.
» Start: Begins the current batch setup.
» Setup: Opens the Setup portion of the Batch Processing window.
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Chapter 9: Trouble Shooting Guide

1. Halogen Lamps do not work:

e Ensure the White Wires from lights are connected to the Black (or negative)
Terminal on the MFJ Power Supply.

e Ensure the Black Wires from lights are connected to the Red (or positive) Terminal
on the MFJ Power Supply.
Ensure both lights are switched off and the MFJ Power Supply is plugged in.
Switch the MFJ Power Supply on; and then turn the “DC Adjust Knob™ all the way
to the left (counter-clockwise).

e Switch both Halogen Lamps on (switch is on top of each lamp).

e On the MFJ Power Supply — turn the “DC Adjust Knob” clockwise to the right until
the “Voltage Reading” dial is 12 Volts. It is important for the consistency of the
images that this dial is set on 12 Volts every time.

® Note: Failing to follow this sequence will cause the MFJ Power Supply to fail to
function properly.
2. Computer does not recognize Camera:
. Ensure camera power adapter is plug in.
. Listen and see if the fan motor is running on the side of camera. If not, unplug and
plug the power cable back into the top of the camera.
e Ensure the blue cable is properly connected. Ensure it is plugged into a card port on
the back of the camera and not a standard port.
e Restart the computer.
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